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MOLECULAR MODELLING EXERCISES 
 
EXERCISE 26.1    Factor Xa inhibitors 
 
INTRODUCTION 
 
Factor Xa is an enzyme involved in blood coagulation. Therefore, Factor Xa inhibitors are 
agents that can be used as anticoagulants (section 26.9.1.3 in the textbook). Three have 
reached the market to date (Fig. 1). Crystal structures of Factor Xa with bound apixaban or 
rivaroxaban have been published. We will use these crystal structures to identify their active 
conformation, and the manner in which they bind to Factor Xa. From this, we will propose an 
active conformation for edoxaban. 
 
 
 
 
 

 
 
Apixaban      Edoxaban 
 

 
Rivaroxaban 
 
 
Figure 1 Factor Xa inhibitors. 
 
INSTRUCTIONS 
It is suggested that you attempt the following instructions yourself before following the more 
detailed Procedures that follow. You may find the file entitled Common Operations for 
ChemBio3D/Chem3D a useful guide on how to carry out various operations. 
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PART A 
*Create the energy-minimised 3D-structures of all three inhibitors (apixaban, rivaroxaban 
and edoxaban) from their ChemDraw files (available from the ChemDraw folder). 
*Identify the number of rotatable bonds in each structure. 
*Identify the number of hydrogen bond donors and hydrogen bond acceptors in all three 
structures. 
PART B 
*Download the crystal structure of Factor Xa with bound apixaban (pdb 2P16).  
*Identify the structural features of the crystal structure. 
*Identify the location of the binding site and apixaban. 
*Extract apixaban from the binding site and identify the active conformation. 
*Compare the active conformation of apixaban with the energy-minimised conformation from 
part A. 
PART C 
*Identify the amino acid residues closest to apixaban in the binding site. 
*Create a model binding site where the amino acids are labelled. 
PART D 
*Create a model binding site which includes hydrogen atoms on the amino acid residues and 
apixaban. 
*Correct any errors in the structure of apixaban that might be present. 
*Identify any hydrogen bonds that have been detected by ChemBio3D/Chem3D between 
apixaban and the binding site. 
*Measure the lengths of any hydrogen bonds. 
*Identify the binding interactions expected from PoseView. 
*Identify any interactions between apixaban and Glu-146.  
*Identify any interactions between apixaban and Gly-216.  
*Identify the binding pocket for the methoxy-substituted ring of apixaban. 
PART E 
*Download the crystal structures of Factor Xa with bound rivaroxaban (pdb 2W26).  
*Identify the location of the binding site and rivaroxaban. 
*Describe the active conformation of rivaroxaban. 
*Identify the amino acid residues closest to rivaroxaban in the binding site. 
*Create a model binding site where the amino acids are labelled. 
*Compare the active conformations of apixaban and rivaroxaban. 
*Measure the distance between the rings at the tips of the L-shaped active conformation for 
both apixaban and rivaroxaban. 
*Overlay the structures of the two active conformations 
*Create a model binding site of rivaroxaban bound to Factor Xa that includes hydrogen atoms. 
Correct any errors in the structure of rivaroxaban. 
*Use the PoseView image from the pdb website to identify likely binding interactions 
between rivaroxaban and the binding site. 
*Identify any interactions between rivaroxaban and Gly-219. 
PART F 
*Compare the structure of edoxaban with apixaban and rivaroxaban. Propose the feature in 
edoxaban that might act as a central scaffold, and the moieties that might represent the two 
arms of the L-shaped active conformation. 
*Create an energy-minimised L-shaped conformation that could be a possible active 
conformation for edoxaban. 
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*Measure the distance between the rings at the ends of the two arms of the L-shaped 
conformation and compare this with the equivalent separations for apixaban and 
rivaroxaban. 
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PROCEDURES 
There are various approaches that you can use in these molecular modelling exercises. The 
following procedures illustrate how you might tackle this particular exercise, but are not 
meant to be prescriptive. Note also that the results obtained may vary depending on the 
computer used and the version of ChemBio3D or Chem3D used. For example, the specific 
conformations obtained from energy minimisation may differ, as may quantitative results 
such as steric energies. 
 
PART A  Build energy-minimised 3D-models of all three Factor X inhibitors. 
 
1. Create the energy-minimised 3D-structure of apixaban 
Use the ChemDraw file for apixaban (available in the ChemDraw folder) to create the 3D 
model as follows. 
*Open ChemBio3D or Chem3D. 
*From the File menu, choose Open, then select the ChemDraw file for apixaban from the 
ChemDraw folder. Click Open.  

*Energy minimise the structure .  
 
You should get something like the following (Fig. 3). The steric energy is given in the bottom 
window as 57.9 kcal/mol.  
 

 
Figure 3  Energy-minimised structure of apixaban. 
 
2. Create the energy-minimised 3D models for edoxaban and rivaroxaban. 
The same procedures are carried out to create 3D models of edoxaban and rivaroxaban from 
their ChemDraw files (also available from the ChemDraw folder (Fig. 4). Edoxaban energy 
minimises with a steric energy of 33.7 kcal/mol. Rivaroxaban energy minimises with a steric 
energy of 41.0 kcal/mol. 
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  Edoxaban    Rivaroxaban 
 
Figure 4  Energy-minimised structures of edoxaban and rivaroxaban. 
 
3. Identify the rotatable bonds in all three structures. 
*From the Calculations menu choose Compute Properties. 
*Expand Molecular Topology and select Num Rotatable Bonds. Click OK.  
The numbers of rotatable bonds for apixaban, edoxaban, and rivaroxaban are given as 5, 10, 
and 6 respectively in the bottom window. Note that rotatable bonds in this context are 
defined as those that result in distinct differences in conformation. Rotatable bonds that only 
alter the relative positions of hydrogen atoms (e.g. C-OH, C-NH2, C-CH3 etc) are not included in 
the total. 
Note that ChemBio3D/Chem3D includes amide N-C bonds as rotatable bonds, but these are 
not counted as such when assessing molecules for Veber’s parameters. An amide bond is not 
freely rotatable due to the partial double bond character that is caused by the nitrogen’s lone 
pair of electrons interacting with the carbonyl group. This illustrates that property 
predictions on features such as HBDs, HBAs and rotatable bonds are not necessarily accurate. 
It should also be appreciated that different conformations are possible due to any ring 
flipping that might occur.  
Because of the number of rotatable bonds, there are a large number of possible 
conformations. Therefore, there is no guarantee that the energy-minimised conformations 
obtained for the three inhibitors represent global minima, let alone the active conformations. 
 

  
  A     B 
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     C 
 
Figure 5  Rotatable bonds shown in red that would result in significantly different 
conformations for A) apixaban, B) edoxaban and C) rivaroxaban. Bonds shown in blue are not 
freely rotatable but have been identified as such by ChemBio3D/Chem3D. 
 
4. Identify the number of hydrogen bond acceptors and hydrogen bond donors in the 
structures. 
 
*From the Calculations menu, choose Compute Properties.  
*Expand ChemPropPro.  
*Click on Lipinski’s Rule, then click OK.  
The molecular weight, number of HBAs, number of HBDs, number of rotatable bonds, and log 
P values are shown in the bottom window (Table 1). The HBAs and HBDs in the structure are 
not specifically identified by Chem3D and are shown in figure 6. Note that nitrogen atoms 
next to carbonyl groups are not counted as HBAs because the lone pair of electrons can 
interact with the carbonyl group.  
 
Apixaban 459.191; 6 HBA; 1 HBA; 5 rotatable bonds; and logP 1.892 
Edoxaban 546.182; 7 HBA; 2 HBD; 10 rotatable bonds; and logP -0.257 
Rivaroxaban 435.066; 4 HBA; 1 HBD; 6 rotatable bonds; and logP 2.394 
 
Table 1  Predicted values for Lipinski’ rules. 
 
 

  
 
  A     B 
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   C 
 
Figure 6  A) HBAs and HBDs in the structures of A) apixaban, B) edoxaban, and C) 
rivaroxaban. (HBA) indicates a weak HBA. 
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PART B  The crystal structure of the factor Xa enzyme with bound apixaban. 
By studying the crystal structure of the enzyme with bound apixaban, it is possible to identify 
the binding site and the active conformation of apixaban. 
 
1.Open the pdb file for the ligand-protein complex (pdb code 2P16). 
 
You will need to be connected to the internet in order to do this.  
*From the Online menu, choose Find Structure from PDB ID (PDB stands for the protein 
data bank).  
*Enter the PDB code for the relevant protein (2P16).  
*Click on Get File.  
 
The protein will appear as a ribbon diagram, with any ligands presented as a ball and stick 
model (Fig. 7A).  You will see evidence of alpha helices (coils) in light purple, beta-pleated 
sheets (broad arrows) in dark blue, and connecting strands in pink. The secondary features 
can be distinguished more clearly by recolouring the structure. 
*From the File menu, choose Model Settings.  
*Click on the tab for Colors and Fonts.  
*Under the section on Model Colors, modify the colours used for the Alpha helix, Beta sheet 
and Coil. Choose red for alpha helices, blue for sheets and green for coils.  
*Click on Apply to see the effect in the main window. If satisfied, click OK. 
 
The resulting image (Fig. 7B) shows more clearly that there are 5 helices in the structure, one 
of which has a section missing. This is because that section has not been resolved in the X-ray 
analysis.  
 
 

  
 
Figure 7  A) Protein-ligand complex (pdb code 2P16). B) Recoloured complex. 
 
Note: The stray atom that appears in figure 7 corresponds to Ligand-226 in the Model 
Explorer Table.  Expanding the entry gives an entry for CA-301. Expanding that gives an entry 
CA (2241) indicating that this is a calcium ion. The ion interacts with four amino acid residues 
(Fig. 8).  
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Figure 8 Calcium ion interacting with four amino acid residues highlighted in yellow (Glu-80, 
Gln-75, Asn-72 and Asp-70). 
 
2.Investigate the main features of the crystal structure. 
 
Click on the Model Explorer tab at the left hand margin of the window. This opens up to 
show you that there are 2 protein chains present (Chains A and L) (Fig. 9). Click on each of 
these in turn to see them highlighted in yellow in the window (Fig. 10). 
 

 
Figure 9  Model Explorer table. 
 

 
       
  Chain-L     Chain A 
 
    Figure 10  Identification of features.  
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Note that chain A includes the ligand as well as the protein chain. These can be selected 
separately by going into Model Explorer table (Fig. 9) and clicking on the + sign next to Chain 
A. This expands the entry for Chain A (Fig. 11).  
 

 
Figure 11  Model Explorer – Chain A after expansion. 
 
This reveals entries for three fragments representing amino acids 16-123, 125-222, and 224-
244. There are four ligands listed. The one corresponding to apixaban is Ligand-225. Click on 
that to reveal apixaban in its binding site (Fig. 12). 
 

 
Figure 12  Apixaban highlighted in the crystal structure. 
 
3.  Extract apixaban from the active site.  
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*Use the translate tool  to centre your view on chain A, and use the mouse scroll to zoom 
in on the ligand and the binding site (Fig. 13). This viewpoint demonstrates that apixaban is 
in an L-shaped conformation. One arm of the conformation is bound close to the surface of the 
enzyme., while the other arm is buried more deeply into a binding pocket. 
 

 
 
Figure 13 A close up of apixaban in the binding site. 
 
*In the Explorer Menu, select Ligand-225. The ligand is now highlighted in the main 
window.  
*Copy and paste the structure into a new window (Fig. 14). Do not attempt to energy-
minimise the active conformation or take its steric energy (see note). Figure 14 emphasizes 
the L-shaped conformation of the structure with the bicyclic ring system acting as a scaffold 
to direct the two substituents at right angles to each other. 
 
Note: Carrying out an energy minimization or energy calculation would not be valid and 
would also move the structure away from the active conformation. The extracted structure 
indicates the positions of the atoms as determined by X-ray crystallography and so there is an 
experimental error associated with those positions. This means that there is an experimental 
error involved in bond lengths and bond angles. Any attempt to take the steric energy would 
give a result that is higher than it should be. In addition, the hybridization states of the atoms 
have not been properly identified in the extracted structure. Attempts to energy minimize the 
structure would treat all atoms as sp3 hybridised by default.   
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Figure 14  Active conformation for apixaban. 
 
 
4.  Compare the active conformation of apixaban with the energy-minimised structure 
obtained in Part A. 
*Copy and paste the active conformation and the energy-minimised structure into a new 
window. 
*Align them side-by-side in similar orientations (Fig. 15) 
The active conformation of apixaban is on the left in figure 15, and the energy-minimised 
conformation is on the right. The structures are quite similar in having an L-shaped 
conformation, but the orientation of the methoxyphenyl ring is different. It has an orthogonal 
arrangement with respect to the bicyclic ring in the active conformation. There is also a 
difference in the orientation of the aromatic ring linking the bicyclic scaffold to the lactam 
ring.  
 

 
Figure 15  Comparison of A) the active conformation vs B) the energy-minimised structure. 
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PART C  Extracting apixaban and closest amino acids 
Apixaban and closest amino acids can be extracted as follows. 
*Zoom in on the ligand in the binding site.  
*Double click on any of the atoms to select it.  
*Keep the mouse over one of the selected atoms, then right click the mouse to open a menu. 
*Choose Select, then Select groups within Distance of Selection. Finally, select 4 Angstrom 
(Fig. 16). 
*From the Edit menu, choose Copy.  
*From the File menu, choose New, then paste the selection into the new window (Fig. 17).  
 
 
 
 
 

 
 
Figure 16  Apixaban and closest amino acids. 
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Figure 17  The initial pasted selection. 
 
The resulting image (Fig. 17) needs to be tidied up to distinguish between apixaban and the 
amino aid residues. To make the selection clearer, it is worth hiding the ribbon feature and 
displaying the ligand in a different display mode from that used for the amino acid residues. 
Water molecules can also be removed. The following operations will display the ligand as a 
ball and stick model, and the amino acid residues as sticks.  
*From the View menu choose Model Display, Display Mode, Sticks. 
*From the View menu choose Model Display and Show Residue Labels 
*In the Model Explorer table, click on Solvent, then right click the mouse to reveal a menu. 
Choose Cut. This allows the structure to be rotated and translated more easily 
To alter the ligand back to ball and stick, carry out the following. 
*Select the ligand by double clicking on any of the atoms belonging to it.  Alternatively, open 
the Model Explorer Menu (Fig. 18A) and expand the entry for Chain A (Fig. 18B), where the 
ligand is present as Ligand-225. Click on Ligand-225 to select it. 
 

    
 A   B 
 
Figure 18  Model Explorer Table. 
 
*Make sure that the mouse is placed over the selection and right click the mouse to produce a 
menu.  
*Choose Display Mode, then Ball and stick. 
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A ball and sphere model of the binding site is now visible with the ligand in Ball and Stick 
format, and the amino acid residues as sticks (Fig. 19). Residue labels will also be visible.  
Note that no hydrogen atoms are shown, so it is not possible to measure hydrogen-bond 
distances. 
 
 
 
 

 
 
Figure 19  Apixaban in its binding site. 
 
*Reorientate the image to emphasise the L-shaped ligand (Fig. 20). It is clear that most of the 
ligand is binding near the surface of the protein, whereas the methoxy-substituted aromatic 
ring sinks into a pocket within the binding site. 
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Figure 20  Apixaban in its binding site. 
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PART D  A model binding site for apixaban and Factor Xa including hydrogen atoms 
In this part of the exercise, the ligand and closest amino acid residues will be copied as a 
ChemDraw structure, such that hydrogen atoms can be added to apixaban and the amino 
acid residues. This will allow the identification and measurement of hydrogen bonds between 
apixaban and the binding site.  
 
1. Extract apixaban and the closest amino acids as a ChemDraw structure. 
*Return to the window containing the crystal structure. 
*Select the ligand and closest amino acids as previously described. If they are already 
selected, choose the translate or rotate tool, then click in the main window to activate it. 
*From the Edit menu choose Copy As, then choose ChemDraw Structure. 
*Paste the selection into a new window (Fig. 21). 
 

 
 
Figure 21  The initial pasted selection. 
 
2. Modify the image of the model binding site to distinguish apixaban. 
The image of the model binding site is modified as follows 
*From the View menu choose Model Display, then Display Mode. Select Sticks. 
To alter the ligand back to ball and stick, carry out the following. 
*Select the ligand by double clicking on any of the atoms belonging to it.  Alternatively, open 
the Model Explorer Menu (Fig. 22) and select Fragment-1.  
 

   
Figure 22 Model Explorer Table. 
 
*Keep the mouse over the selection then right click the mouse to reveal a menu. 
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*Choose Display Mode, then Ball and stick.  
(Alternatively, you can double click on the ligand to select it, then right click the mouse to 
show the same menu. Make sure that the mouse cursor is over one of the selected atoms.) 
*In the Model Explorer table, click on Solvent, then right click the mouse to reveal a menu.  
*Choose Cut. This allows the structure to be viewed more clearly and also allows it to be 
rotated and translated more easily.  
Unfortunately, it is not possible to label the amino acid residues in this version of the extract. 
However, it is possible to show hydrogen atoms and hydrogen bonds, although there are 
flaws as described later.  
*From the View menu, choose Model Display, then Show Hydrogen Atoms. Select Show 
Polar 
*From the View menu, choose Model Display, then choose Hydrogen Bonds. Select Show 
Intermolecular. 
 
The resulting model binding site shows hydrogen atoms on the nitrogen and oxygen atoms of 
the ligand and amino acid residues, but not all of these should be present (Fig. 23). 
 
 
 

 
 
Figure 23 Binding site and ligand with hydrogen atoms (some of which should not be 
present). 
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The hydrogen atoms added to the amino acid residues are accurate, but the program has 
assumed that all the atoms present in apixaban are sp3 hybridised when adding hydrogens.  
This results in incorrect features such as hydrogen atoms on carbonyl oxygen atoms (Fig. 
24A). The structure can be corrected by selecting the offending hydrogen atoms, then hiding 
them (Fig. 24B). 

*Use the select tool to select an erroneous hydrogen atom, then right click the mouse 
whilst holding it over a selected atom.  
*From the menu that appears, choose Visibility then Hide Atom.  
In this structure, three H’s have been wrongly added to the carbonyl oxygen atoms, and a 
nitrogen of the bicyclic ring (Fig. 24A). These should all be hidden (Fig. 24B) 
 

     
  
 
 
Figure 24  A) Structure with wrongly added hydrogen atoms B) Corrected structure. 
 
Correcting apixaban in the model binding site produces figure 25.  
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Figure 25  Corrected structure of apixaban in the binding site. 
 
3. Identify any hydrogen bonds between the ligand and the binding site 
Only one H-bond is visible (Fig. 26). This involves one of the primary amide protons.  
To measure the H-bond distance, carry out the following. 
*From the View menu, choose Model Display, then choose Perspective. 
*Choose the Select tool. 
*With the shift key depressed, click on the HBD (the amide proton) and the HBA (the oxygen 
of the amino acid residue), such that they are both highlighted. 
*From the Structure menu, choose Measurements, then Display Distance Measurement. 
The bond length is 2.2 Å. 
*Use the model binding site created in part C to identify the amino acid residue involved. 
View the binding site in Perspective when doing so. 
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Figure 26  H-bond interaction involving the primary amide. 
 
The interaction is to a peptide carbonyl group for a glutamate residue (Glu-146) (Fig. 27). The 
peptide bond is between Glu-146 and Lys-147. This can be identified from the Model Explorer 
table in the window containing the original crystal structure. Expand Chain-A (Fig. 28A), then 
expand Fragment 125-222, to locate Glu-146 (Fig. 28B). 
 
 

 
 
Figure 27 Model binding site identifying Glu-146. 
 



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

  
Figure 28  A) Model Explorer Table with Chain A expanded. B) Expansion of Fragment 125-
22 and location of Glu-146 with neighbouring amino acid residues. 
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4. Identify hydrogen bonds predicted by the Poseview image 
The Poseview image is obtained from the protein data base web site as follows. 
*The protein data bank can be accessed at www.rcsb.org.  
*On the home page of the web site, locate the search box. Enter the PDB code 2P16, then click 
on Go. You will now have the front page of that file.  
*Scroll down the page to a section headed Small Molecules, which refers to any ligands 
bound to the protein. Under the section on ligands, there are two diagrams shown under 2D 
Diagram and Interactions. The left-hand structure shows the structure of the ligand. The 
right-hand diagram shows intermolecular binding interactions between the ligand and key 
amino acids within the binding site.  
*Click on the right-hand diagram to get a window showing an expanded view of the Poseview 
Image. Hydrogen bonds are shown by dashed lines. Hydrophobic pockets are shown by green 
lines with the amino acids involved identified in green.  
 
The Poseview image shows that 2 H-bond interactions are possible (Fig. 29). 
ChemBio3D/Chem3D identified the interaction with Glu-146, but not the one with Gly-216. 
 

 
 
Figure 29 PoseView image. 
 
 
5. Identify the hydrogen bond between apaxaban and Gly-216.  
*Zoom into the relative part of both model binding sites created earlier. 
*Identify the HBD and the HBA and select both atoms. 
*From the Structure menu, choose Measurements, then choose Display Distance 
Measurement. 
Figures 30A&B show that the interaction between Gly-216 and the carbonyl oxygen of the 
bicyclic ring, involves the NH proton of a peptide link. The peptide bond is between Gly-216 

http://www.rcsb.org/
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and Trp-215. The measured distance between the HBD and HBA is 2.0 Å, which demonstrates 
that a H-bond is feasible. 
 
A) 

 
B) 

 
 
Figure 30 A) Interactions involving Gly-216. B) Identification of amino acids and peptide 
bonds involved. 
 
6. Identify the pocket for the methoxy-substituted aromatic ring 
*Return to the copy of the binding site obtained in Part C (Fig. 20).  
*From the View menu, choose Model Display, then Perspective. 
*Zoom into the relevant area to identify possible interactions. 
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The aromatic ring is sandwiched between two peptide bonds (Fig. 31). One of the peptide 
bonds (the bottom one in figure 31) is between Gly-216 and Trp-215. The other one (the top 
one in figure 31) is between Cys 191 and Ala190. The closest interactions between the 
aromatic carbon atoms and the peptide regions measure 3.5-4.0 Å (Fig. 31).    
 
 

 
 
Figure 31 Interactions between the aromatic ring and the peptide groups. 
 
 
 
 
 
 
 
  



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

PART E  Rivaroxaban 
 
1. Open the crystal structure of the factor Xa anxyme with bound rivaroxaban. 
The same procedures described previously are used to open the pdb file for factor Xa with 
bound rivaroxaban (pdb file 2W26) (Fig. 32).  
 

 
Figure 32 Crystal structure of factor Xa and bound rivaroxaban. 
 
2. Identify rivaroxaban and the binding site. 
 
*Zoom into the binding site and identify rivaroxaban 
Zooming into the structure shows that rivaroxaban binds to the same region of the protein as 
apoxaban, and adopts a similar L-shaped conformation (Fig. 33). 
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Figure 33 Close up of rivaroxaban bound to the active site of factor X. 
 
*Open the Model Explorer table and find the entry for rivaroxaban. 
 Opening the Model Explorer Table reveals that rivaroxaban is included in the label for Chain 
A, and is labeled as Ligand-17 (Fig. 34). Clicking on Ligand-17 highlights rivaroxaban in 
yellow (Fig. 35). 
 
 

   
 
Figure 34 Rivaroxaban labeled as Ligand-17. 
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Figure 35 Rivaroxaban highlighted in yellow. 
 
2. Extract rivaroxaban and closest amino acid  residues. 
 
*Select rivaroxaban and the closest amino acid residues. 
Rivaroxaban and the closest amino acid residues can be selected as previously described (Fig. 
36). 
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Figure 36 Selection of rivaroxaban and closest amino acid residues. 
 
*Copy and paste the selection into a new window. 
The selection can be copied then pasted into a new window to give an initial image as shown 
in figure 37. 
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Figure 37 Initial paste of the copied selection of rivaroxaban and closest amino acid residues. 
 
3. Modify the image to distinguish between rivaroxaban and the amino acid residues. 
The image is modified as described previously such that the amino acid residues are shown in 
Stick format, and rivaroxaban is shown in a Ball and Stick format. Rivaroxaban is selected by 
clicking Ligand-17 in the Model Explorer table (Figs. 38 and 39).  
 
 

 
Figure 38  Identification of rivaroxaban (Ligand -17) in the Model Explorer table. 
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Figure 39  Highlighting rivaroxaban (Ligand -17). 
 
Rivaroxaban is then altered to a ball and stick model to distinguish it from the surrounding 
amino acid residues (Fig. 40). 
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Figure 40  Binding site showing amino acid residues in stick format with labels, and 
rivaroxaban in ball and stick format. 
 
4. Compare the active conformations of apixaban and rivaroxaban. 
The structure of rivaroxaban can be selected and copied, then pasted into a new window for 
comparison with apixaban (Fig. 41). Both molecules have L-shaped conformations with one 
arm of the ligand binding at the surface of the enzyme and the other arm (containing a 
substituted aromatic or heteroaromatic ring) sinking into a pocket within the target binding 
site. Both structures have a scaffold ring that directs the substituents into the L-shape. In 
apixaban, the scaffold is a bicyclic ring system. In rivaroxaban, it is a monocyclic ring. Both 
structures have an aromatic ring that links the scaffold to a lactam ring.  The aromatic ring 
and the lactam ring are similarly orientated and are orthogonal to each other. However, the 
central scaffold ring is orientated differently. The bicyclic scaffold of abixaban is orthogonal to 
the linking aromatic ring, whereas the heterocyclic scaffold in rivaroxaban is coplanar. This is 
shown more clearly in figure 42 where the distance between the centroids of the terminal 
rings are defined. 
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 A      B 
Figure 41 Comparison of the active conformations of A) rivaroxaban and B) apixaban. 
 
5. Measure the distance between the aromatic/heteroaromatic rings at the ends of the 
L-shaped molecules.  
*Choose the select tool. 
*With the shift key depressed, click on all the atoms making up one of the terminal rings in 
apixaban. 
*From the Structure menu, choose Add Centroid. 
*Repeat this process to add a centroid to the other terminal ring. 
*Use the select tool to select both centroids in apixaban. 
*From the Structure menu, choose Measurements, then choose Display Distance 
Measurement. 
*Repeat this process for rivaroxaban. 
 
The distance between the centroids was measured as 11.0 Å and 10.8 Å for rivaroxaban and 
apixaban respectively (Fig. 42). These are very similar. 
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  A     B 
Figure 42 Separation of the centroids in rivaroxaban and apixaban  
 
6. Overlay the structures.  
*Copy and paste both molecules into a new window. 
*From the Structure menu, choose Measurements, then Clear. 
*Choose the Eraser tool and click on the centroids to remove them. 
*Align the molecules side by side in similar orientations. 
*Recolour the structure of rivaroxaban. 
*Pair up the atoms of the linking aromatic ring as shown in figure 43. 
*Overlay the structures.  

 
Figure 43  Pairing up atoms in the orthogonal rings. Rivaroxaban is coloured green. 
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In the trial experiment, the overlay halted prematurely and so the structures were overlaid 
manually until the paired atoms were within 0.3 Å. Another overlay was then carried out, 
which brought the paired atoms within 0.1-0.2 Å (Fig. 44). The overlay emphasizes the 
different orientations of the scaffold rings, which are orthogonal to each other. The fact that 
they are orthogonal to each other implies that the scaffold rings are not crucial to ligand 
binding.  
 

 

 
 
Figure 44 Overlay of the structures from 3 different perspectives. Rivaroxaban is coloured 
green. 
 
7. Identify any hydrogen bonding interactions between rivaroxaban and the binding 
site. 
Hydrogen atoms and hydrogen bonds were not visible in the model binding site created in 
figure 40. However, we can create such a model binding site by copying rivaroxaban with 
surrounding amino acid residues as a ChemDraw structure. 
*Select rivaroxaban and the amino acid residues within 4 angstroms. 
*Copy the selection as a ChemDraw structure. 
* Paste the selection into a new window to give the initial image shown in figure 45. 
 



Patrick: An Introduction to Medicinal Chemistry 6e 
 

 

© Oxford University Press, 2017.  

 
 
Figure 45 Initial model binding site. 
 
*Clean up the image as previously described to show the amino acid residues and the ligand in 
stick format. Show only the polar hydrogen atoms and the intermolecular hydrogen bonds, 
and cut solvent molecules. The resulting model binding site is shown in figure 46. 
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Figure 46  The model binding site showing amino acids and ligand in stick format. 
 
We will now convert rivaroxaban back to a ball and stick model. Rivaroxaban is Fragment 3 
in the Model Explorer table (Fig. 47).  
*Select the ligand and change it to a ball and stick format (Fig. 48). 
 

  
Figure 47 Model Explorer table for the binding site model.  
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Figure 48 The binding site model with amino acid residues in stick format and the ligand in 
ball and stick format.   
 
This is nearly ready for analysis, but it is necessary to hide any hydrogen atoms on 
rivaroxaban that should not be present on sp2-hybridised atoms (such as carbonyl oxygens).  
 
*Use the select tool to highlight an erroneous hydrogen atom. 
*Hover the mouse over the selected atom and right click the mouse to open a menu. 
*Choose Visibility, then choose Hide. 
*Repeat this process to hide all the hydrogen atoms shown on oxygen atoms 
The faulty structure of rivaroxaban is shown in figure 49A, and the corrected structure is 
shown in figure 49B.  
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Figure 49  Comparison of A) the faulty structure and B) the corrected structure of 
rivaroxaban.  
 
Once the erroneous hydrogen atoms have been hidden, the model binding site is as shown in 
figure 50. 
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Figure 50 Corrected binding site model with amino acid residues in stick format and the 
ligand in Ball and Stick format.   
 
ChemBio3D/Chem3D has not identified any H-bonds between rivaroxaban and the binding 
site.  
 
8. Access the Poseview image of rivaroxaban in the binding site of Factor Xa. 
 *Access the Poseview image of the binding interactions between rivaroxaban and the binding 
site (Fig. 51). This reveals that 2 H-bonds are possible with Gly-219. 
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Figure 51  Poseview image of rivaroxaban interacting with the binding site. 
 
9. Identify interactions with Gly-219 in the model binding sites 
 
The interactions with Gly-219 involve the central scaffold ring of the ligand and the amide 
bond. Zooming into that region allows the distances to be measured for the proposed 
hydrogen bonds (Fig. 52). 
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Figure 52  Distances for the proposed hydrogen bonds. 
 
The distance between the carbonyl oxygen of the ligand’s scaffold ring and the N-H proton of 
the peptide bond involving Gly-219 is 2.0 Å, which indicates that a strong H-bond is likely. 
The distance between the NH proton of the ligand’s amide group with the peptide carbonyl 
oxygen of Gly-21 is longer at 2.8 Å. This is less convincing. However, the orientation of the N-
H proton is faulty since the program assumes the nitrogen is sp3 hybridised. Due to the partial 
double bond character of a peptide bond the N-H proton should be pointing more towards the 
carbonyl oxygen than shown. This would shorten the separation and make a hydrogen bond 
more likely. 
 
Figure 53 reveals that the peptide bonds involved in these interactions are between Gly-219 
and Cys-220 (involving the carbonyl oxygen atom), and between Gly-219 and Glu-217 
(involving the NH proton). 
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Figure 53  Identification of  amino acids linked to Gly-219.  
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PART F   
No crystal structure is available for FactorXa containing bound edoxaban, and so we have to 
propose an active conformation based on the information we have obtained for apoxaban and 
rivaroxaban.  This information clearly indicates the importance of an L-shaped molecule. We 
will now modify the energy-minimised structure for edoxaban into an L-shape.  
 
*Go to the window containing the energy-minimised structure of edoxaban prepared in part A 
(Fig. 54). This initial conformation had a steric energy of 33.7 kcal/mol. 
 
*Copy and paste the structure into a new window. 
*Identify the features that might correspond to the central scaffold, and the two arms of a 
possible L-shaped conformation.   
 

 
 
Figure 54 Initial conformation of edoxaban 
 
Edoxaban contains a chloro-substituted pyridine ring which may well mimic the chloro-
substituted ring of rivaroxaban. This is connected via an oxamide linker to a cyclohexane ring 
can serve as the central scaffold for the L-shaped conformation. There are another two 
substituents present and the longer one containing the bicyclic ring system is the better 
option for the second arm of the ‘L’. 
*Use the rotation dial to rotate single bonds in order to create a proposed L-shaped 
conformation. 
By manually rotating bonds in this way, the following energy-minimised L-shaped molecule 
can be created with a steric energy of 32.7 kcal/mol (Fig. 55A). This is actually slightly more 
stable than the original conformation. 
*Add centroids to the rings at each tip of the L-shape (Fig. 55B). 
*Measure the distance between the centroids. For the conformation shown, this comes to 11.6 
Å. This is slightly longer than the equivalent separations for adoxaban and rivaroxaban (10.8 
Å and 11.0 Å), but is sufficiently close to make the conformation a viable proposal as the 
active conformation. 
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  A      B 
Figure 55  A) Energy minimized L-shaped conformation as a proposed active conformation. 
B) Distance between the centroids of the termini rings.  
 
The structure of the proposed active conformation is compared with the active conformations 
of adixaban and rivaroxaban in figure 56. 

 
 A    B    C 
Figure 56 Comparison of the L-shaped active conformations of A) apixaban and B) 
rivaroxaban with the proposed active conformation of C) edoxaban. 
 
 
 
 
 


